
Excel

Chapter 1: Getting Started

Excel is a computer program. It's made for making graphs and charts, comparing sets of

numbers, and keeping track of numbers, events, and other things. If you have a printer, you can print out

what you make. This guide is designed to be a quick, easy read to help you learn how to use Excel.

If you're not sure how to use a computer at all, try reading the first guide in this series, The

RealQuick Guide to Using Your Desktop Computer.

These instructions are for Windows computers. Mac computers might be a little different.

This is how to get to the Excel program.

If your computer is not on, press the on button.

After you start up your computer, you need to open up the program. Look on the computer

screen for a bunch of little pictures—these are called icons. If you see a green one with an E on it, look at

the little letters right underneath it. If it says “Excel”, that’s the one! Click the picture twice really fast.

That’s called double-clicking.

If you don’t know what I mean by “click on”,

or if your mouse isn’t working, go to chapter 8.

If you don’t see that little E icon on the screen, there’s another way to find the Excel program. Go

to the bottom of your screen, and on the bottom left hand corner you should see a button with the

Windows logo on it. That’s the Home button. Click that button and a menu should pop up. If you see

Excel listed, click on it. If you don’t see Excel listed on the menu, find the thin little white box near that



home button. Click on it and type Excel. If the little E picture appears when you type Excel, click on the

picture.

If you don’t know what I mean by “type”,

or if your keyboard isn’t working, go to chapter 9.

If you still don’t see Excel anywhere, you might not have it on your computer at all. Visit

www.microsoft.com to get it for your computer.

Now that you’ve got the Excel program open on your computer, you’ll see one of two things.

A) You’ll see a bunch of little boxes in a grid pattern. If you see this, great! You can click on a box

to select it, and start typing in it.

B) You’ll see a green border on the left side and a bunch of little pictures. That’s the default

menu for Excel. Click on the first picture listed, it should say something like “Blank workbook”. A bunch of

little boxes in a grid pattern should appear. You can click on a box to select it, and start typing.

The keyboard is just the same as a typewriter. Press the key, and the letter appears on the

screen.

You can move between boxes in three different ways:

1. You can click on the box you want to type in

2. You can use the arrow keys on your keyboard

3. You can use the “tab” key on your keyboard

Look in the top right corner of your screen. There should be three buttons next to each other.

The first button shrinks the box so you can come back to it later. The second button makes the

box bigger or smaller. The third box, with the X on it, closes the program and makes the box go away. If



you are working on something in the program, make sure you click the save button before you click the X

to close the program. Otherwise, your work might be lost.

You can undo something by clicking on the rounded arrow button pointing to the left on the top

left-hand side of your screen.

You can redo something by clicking on the rounded arrow button pointing toward the right on

the top left-hand side of your screen.

Always remember to save your work every once in a while so that you don't lose it. The little

square at the very top of your screen close to the left side is the "Save" button. If you know what a

floppy disk is, that's what the button looks like. Click this button to save your work so that you can get

back to it later.



Chapter 2: How to make a table in Excel

A table is used to show information in labeled, organized boxes.

Click on the first little white box on your page. It will have the letter A just above it and the

number 1 just on its left. Each of these little boxes are called “cells”. This is cell A1.

Type the name of the information you want to put in the first column. (“columns” are everything

in a straight line going up and down.)

You can make what you type a little bigger by clicking on the button in the top menu that looks

like a thick letter “B” (not the skinny one between A and C: it’s above those). You can get to it by clicking

on the “Home” button at the top left side of your screen, and then looking for the “B” button near the

left side of the menu. The “B” stands for Bold. You can also underline it if you want by clicking the

underlined “U” button nearby. The “U” stands for Underline.

Now click on the box (also called a cell) next to the one you just typed in. You should see the

skinny letter B in the gray box right above it.

Type the name of the information you want in the second column (what you want to title all the

information that’s going to go underneath it). You can repeat these instructions to make as many

columns as you need.

Now, add in your information. Click on a cell to move to it, or if it’s faster, you can use your arrow

keys or “tab” key on your keyboard. Type the information in the spots they belong.

This is fine for just recording the information, but if you want to or need to, you can format it as

a table like this:

Click on the first top corner box, the very first box you typed in, and hold down that mouse

button. Pull your mouse to the bottom of the whole table so that the table has a gray box over it. Now

let go of that mouse button. The gray box should still be there. This is called “highlighting”.

Then click the “Home” button at the top of your screen. On that menu, click on the button

labeled “Format as Table” and choose from the list that appears.

You’ve just made a table in Excel!



Chapter 3: How to make a graph or chart in Excel

A graph is a picture used to show information in a way that’s useful for comparison.

First, you have to make a table with your information. Follow the instructions in the last chapter

of this book to make your table.

After you’ve made your table, it’s easy to make a graph!

Use your mouse to highlight the table you just made.

Go up to the top of your screen and click on the button that says “Insert”.

The menu at the top of the screen should change. In the middle of the menu, you should see a

bunch of little pictures that look like graphs and charts.

Find the picture that looks the most like the graph or chart you want to make. Click on one of the

pictures to choose it. Once you click on one, it might give you more options to choose from. Once you’ve

picked a graph or chart, click on it, and it should appear on your screen.

You’ve just made a graph or chart in Excel!



Chapter 4: Other Excel Features

Excel has more exciting features that can make your work a lot easier. You’ll get better at using

this program with practice. Here’s a list of just a few things that Excel can do:

● Automatically add up numbers: Use your mouse to highlight numbers that you want to

add together. Click on the “Home” button at the top of your screen. Then click on the

“AutoSum” button on the right side of your screen. The numbers will be automatically

added together.

● Other math: Highlight the cells you want to calculate and click the arrow next to

“AutoSum”. You can choose the automatic calculations you want to do for the cells you

highlighted. You can find even more calculations to use in the Formulas menu. Access

the Formulas menu by clicking the word “Formulas” at the top of your screen.

● Combine cells: Highlight the empty cells that you want to combine. Then, click on the

“Home” button at the top of your screen. Click on the button near the middle of the

menu that says “Merge and Center” to turn the little cells you highlighted into one big

cell.

● Change the numbers in the cells you’ve highlighted into different formats, like Currency,

Percentages, Fractions, Dates, and Times by clicking on the “General” button in the

middle of the “Home” menu. Choose the format you want from the dropdown menu

that appears.



Chapter 5: Changing What Your Project Looks Like

No matter what project you're working on using Excel, you can change the appearance of your

work by using the buttons at the top of your screen.

The easiest way to change what your project looks like is to change the size and style of the cells

(boxes) and the letters and numbers inside them. Here's how you change those.

If you haven't typed anything yet, you can skip to the next step. Click your right mouse button on

the cell you'd like to change. If you want to change more than one cell at the same time, click and hold

that mouse button down and move the mouse over all the cells you'd like to change. A gray box should

appear over the cells you want to change. This is called "highlighting". Once you've highlighted

everything you'd like to change, let go of the mouse button. The gray box should stay there.

Changing the Cell Style

To change what your cells look like, press the “Home” button at the top of your screen. On the

menu underneath, there is a section that says “Styles”. Click on the button that says “Cell Styles”. A menu

should appear with a bunch of buttons on it, and they all make the cells you selected look different.

There are other ways to change what the cell looks like, too:

Changing the Color of Your Letters and Numbers

To change the color of what’s in the cells, highlight the cells you want to change, and then click

on the button at the top of the page that says “Home”. A menu will appear underneath what you just

clicked.

On the left side of this menu, there is a capital letter A with a thick line underneath it. That line is

probably black. That color shows what color your letters will be.

To change the color, there is a little upside down triangle next to the A. Click that little triangle. A

list of colors should appear. Choose the color that you want to use, and the things in the cells you

highlighted will change to that color.



Changing the Style of Your Letters and Numbers

To change the appearance of the letters and numbers you type, click on the button at the top of

the page that says “Home”. A menu will appear underneath what you just clicked.

You’ll see a white box on the top left with a little triangle on it. Inside the box it might say

something like “Calibri” or “Arial”. Click on this box to make a list appear.

Choose from one of the font styles listed to make your letters look different. Click on the font

style to select it. You can make the letters fancy and curly, or serious and businesslike.

Changing the Size of Your Letters and Numbers

To change the size of the letters and numbers you type, click on the button at the top of the page

that says “Home”. A menu will appear underneath what you just clicked.

On the left side of this menu, there is a white box with a number in it. This number says how big

your letters are, which is called the “font size”. A bigger number is a bigger size. Click on the box to see

the list of font sizes. Choose from a font size to make your letters and numbers bigger or smaller. Click on

the font size you'd like to select. The standard font size is 12. If you use a font size that's too little,

nobody will be able to read it!

Changing the Color and Size of Your Cells

To change the color of the cells, click on the button at the top of the page that says “Home”. A

menu will appear underneath what you just clicked.

On the left side of this menu, there is a little picture of a can of paint. Click on the little arrow

next to it to show a list of colors to choose from. The color you choose will appear in the cells.

Make cells bigger or smaller by clicking on the lines between the letters at the top of your screen

or the numbers along the left side, holding that mouse button down, and dragging the mouse in the

direction you want the line to go.

Always remember to save your work every once in a while so that you don't lose it. The little

square at the very top of your screen close to the left side is the "Save" button. NOT the X button on the

top right: that will close the program, and you might lose your work if you haven’t saved it.



If you know what a floppy disk is, that's what the “Save” button looks like. Click this button to

save your work so that you can get back to it later.



Chapter 6: Using Templates

Up at the top of the screen, there’s going to be a button that says “File”. Click that button once. A

new list of buttons should appear on your screen. Find the one that says “New” and click that button.

Now a bunch of pictures should be on your screen. Click on the picture that best matches what

you’d like to make. If you don’t see a good match, try typing in what you’re looking for in the thin white

box at the top of your screen. The box has a little picture of a magnifying glass at the end of it. Once

you’ve typed in what you want, either press “Enter” on your keyboard, or click that little magnifying

glass. Then click on the type of project you want to create from the pictures.

Once you choose a picture and click on it, a big version of that picture will appear on your

screen, and you can click and type on it.



Chapter 7: Printing Your Work

Printing out your work is easy if your computer is connected to a printer. If it isn’t already

connected to a printer, follow the instructions that came with your printer to connect it.

Once you’re finished working and you’d like a paper copy of your document, click the “File”

button at the top of your screen. A list of options should appear, and one of them should say “Print”.

Click the “Print” button to go to a new set of options. Here you can tell the computer how many

copies of your document you want to print, which printer you want to use, and if you want to print out

every page or only some of them. It will also tell you how many pages are in your project. Click on these

options to change them.

When you’re ready to print, click the button that says “Print”. It also has a picture of a printer on

it. Your document should print from the printer you’ve selected. If it doesn’t, make sure your printer is

plugged in, turned on, and connected to your computer using the instructions that came with your

printer.



Chapter 8: Clicking, or How to Use Your Mouse

The mouse is the main way to choose things on your computer. It’s a round oval that your hand

fits over with a flat bottom that touches your table or desk. It usually has three buttons on it, but some

have more or less.

Your mouse might have a cord, or it might run on batteries instead. There are two kinds of cords

that attach to mice. One has a circle for an end and the other has a rectangle.

The circular kind plug into the back of the computer into either the green or the purple circle. It

should slide in easily, but snug.

The rectangle-ended kind plugs into one of the small, rectangular slots on the front or back of

your computer. It should fit in easily. If it doesn’t fit easily, the plug might be upside down. Try turning it

over and then plugging it in.

If it’s a battery-powered cordless mouse, make sure the batteries are fresh and the tiny box that

came with it is plugged into one of the small, rectangular slots on your computer.

After you’ve plugged the mouse into the computer, the computer might take a moment to

realize you’ve plugged something in, and it has to figure out what the device is. You should be able to

slide the mouse around on your table or desk, and a little arrow on your monitor screen will move as you

do.

If you see the arrow, but it doesn’t move when you move the mouse, make sure the flat bottom

of the mouse is in contact with some flat surface and then try it again. If it still doesn’t work, try plugging

it into a different slot on your computer. It should fit easily, but snuggly. If it still won’t work, try

restarting the computer (that means turning it off, waiting about ten or fifteen seconds, and then turning

it back on). If you are using an old mouse, or one that’s been damaged, you might need to replace it

before you can use it.

If you move the mouse and the arrow on your monitor screen does too, it worked!



The mouse is used to choose things on the computer, like what to open and where to type.

Move your mouse around, the arrow should follow. The next step is learning how to click on things to

choose them.

There are two main buttons on your mouse, called the left mouse button and the right mouse

button.

Most right-handed people hold the mouse so that their index finger is on the left mouse button,

and their middle finger is on the right mouse button. To click the mouse, press the left mouse button

down, and then let go of it. If you want to interact with something on your screen, use the mouse to

move the arrow on your screen over to what you want to choose. When the arrow is over the thing you

want to interact with, click the mouse: press the left button down, and then let off. Make you’re the

mouse doesn’t move around while you’re clicking, or you’ll have to try again.

If nothing happens when you click, try moving your mouse over to something else to click on.

The right mouse button will show you a small list of options if you press it. To get rid of that list,

click anywhere else with the left mouse button.

There is a third button on some devices in the middle between the left and the right mouse

buttons. This button rolls up and down and is used in some computer programs to show more of the

program. You roll it downward to see further down on the program.



Chapter 9: Typing, or How to Use Your Keyboard

Your keyboard is one way to get around on your computer and on the internet. It’s used for

writing words, numbers, and more. It’s a wide, flat rectangle with a bunch of letters and numbers on it

like a flat typewriter. To type with it, you press the buttons down to make letters and numbers appear on

the screen.

There are two kinds of cords that attach to keyboards. One has a circle for an end, and the other

has a rectangle.

The circular kind plug into the back of the computer into either the green or the purple circle. It

should slide in easily, but snug.

The rectangle-ended kind plugs into one of the small, rectangular slots on the front or back of

your computer. It should fit in easily. If it doesn’t fit easily, the plug might be upside down. Try turning it

over and then plugging it in.

After you’ve plugged the keyboard into the computer, the computer might take a moment to

realize you’ve plugged something in, and it has to figure out what the device is. If it still won’t work after

a few minutes, try restarting the computer (that means turning it off, waiting about ten or fifteen

seconds, and then turning it back on).

Three things on your computer that use the keyboard a lot are Notepad, Word, and the internet.

Let’s try typing something.

On the bottom left corner of your screen, you might see a white box. If you don’t see the white

box, try clicking on the start button, the picture in the very bottom left corner of your screen, and see if

the white box is there. Once you’ve found the white box, try clicking on it and then typing something on

the keyboard.

If the letters show up in the box, it worked! If not, make sure the keyboard is plugged in, click on

the box, and try again. If your keyboard is old or damaged, you may need to get a new one.



If what you typed shows up in the box in ALL CAPITAL LETTERS, press the button on your

keyboard that says Caps Lock. This key makes letters capital or lowercase. If you want to make one letter

at a time capitalized, hold down the shift key and press the letter at the same time.

To go to the next line down, press the enter key.

And to get rid of something you just typed, press the key that says backspace.

To type numbers, press the keys with numbers on them. If you want to type the symbols above

the numbers, hold down the shift key and press the key with the symbol on it at the same time.

If you want to type a punctuation mark that is in the top part of the key, like the question mark,

?, hold down the shift key and press the key with the symbol on it at the same time.

If you open the internet, either from your toolbar at the bottom of the screen or from a shortcut

on the desktop, to get to a website, you type the website’s name or address in the white bar at the very

top of the screen.
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